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ABSTRACT 

USING TECHNOLOGY IN THE CLASSROOM: 

A FACILITATIVE HANDBOOK FOR DEVELOPING A CLASSROOM WEB PAGE 

in THE STANWOOD SCHOOL DISTRICT 

By 

John R. Getzinger 

May 31, 2001 

When technology is used in the classroom, students are prepared for the 

future, the individual needs of students can be met, students are provided with 

interactive learning and the value of computers are demonstrated to students and 

faculty. 

The purpose of this project was to develop a handbook for teachers of 

fourth grade students at Church Creek Elementary in the Stanwood - Camano 

School District that would assist in creating a classroom web page. The web 

page would allow parents and other interested parties to see what was taking 

place in the classroom. In order to create the handbook, the researcher 

examined current research on what is available for classroom use and the 

benefits of using technology in the classroom. 
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Statement of the problem 

CHAPTER 1 

INTRODUCTION 

The Office of Technology Assessment reported in 1999, U.S. schools 

have 5.8 million computers available for instruction. Since 1994, the National 

Center for Education Statistics has documented a large increase in access to 

computers and the Internet in the nation's public schools. A 1999 survey done 

by the NCES (National Center for Education Statistics) found that 99% of full time 

regular public school teachers reported they had full time access to computers or 

the Internet somewhere in their schools. According to the President's 

Committee of Advisors on Science and Technology, the ratio of students per 

computer in the United States were 4 computers to 5 students. Nevertheless, a 

substantial number of teachers still report little or no use of computers for 

instruction (Orwig, 1997). 

"When students communicate with others about their learning, they learn 

about what they have learned, what they need to learn, and what kind of support 

may be available to them. Research shows that when students are involved in 

the assessment process and learn to articulate what they have learned and what 

they still need to work on, achievement improves." (Davies, 2001). It is the 

researcher's goal to help create a bridge that would use technology both as a 

teaching tool and as medium for communication. 

Purpose of the project 

The purpose of this project was to develop a handbook for teachers of 

fourth grade students at Church Creek Elementary in the Stanwood-Camano 

School District that would assist in creating a classroom web page. The web 

page would allow parents and other interested parties to see what was taking 



( place in the classroom. To achieve this purpose, current research, literature, and 

software were reviewed. 

Limitations of the Project 

For the purpose of this project, it was necessary to establish the following 

limitations. 

1. Scope: The Web Page Handbook was developed for use by staff, students 

and administration of Church Creek Elementary School, Stanwood-Camano 

School District #401, Stanwood, Washington. 

2. Participants: Stanwood School District employees who assisted the writer, 

John Getzinger, in planning and implementation of this project included the 

Church Creek Elementary principal, the technology supervisor at Church Creek 

Elementary, and the Church Creek behavior specialist. 

3. Time: The project focused on the school year 1999-2000 

Scope of Project 

This project was written for fourth grade elementary teachers. The project 

has been divided into four sections. The section topics are introduction, available 

software, and setting up a classroom web page, examples of student web pages, 

conclusion and recommendations. The process described in this project is age 

appropriate from third grade through high school. 

The literature review for this project has been divided into two major 

sections. The first section is dedicated to the benefits of technology in the 

classroom. The second section examines what types of technology can be used 

in the classroom. 
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Definition of Terms 

E-mail (Electronic Mail) -
Messages, usually text, sent from one person to another via computer. E-mail 
can also be sent automatically to a large number of addresses (J.W. Hohman, 
personal communication September 8, 2000). 

HTML-
Hyper Text Markup Language the text markup language used to insert tags, 
which allow a Web browser to correctly display a hypertext document. HTML 1, 
HTML+, HTML 2 and HTML 3 are versions of HTML in use at this time. HTML is 
a subset of the Standard Generalized Markup Language (SGML) first invented to 
display legal texts and now the world standard for large documentation projects 
(J.W. Hohman, personal communication September 8, 2000). 

Internet-
The vast collection of inter-connected networks that all use the TCP/IP protocols 
and that evolved from the ARPANET of the late 60's and early 70's. The Internet 
now (January 1996) connects roughly 75,000 independent networks into a vast 
global network (J.W. Hohman, personal communication September 8, 2000). 

Multimedia -
Documents which contain text, sound, graphics and video elements that are all 
capable of being displayed to the user (J.W. Hohman, personal communication 
September 8, 2000). 

Network-
Any time you connect 2 or more computers together so that they can share 
resources, you have a computer network (J.W. Hohman, personal 
communication September 8, 2000). 

URL (Uniform Resource Locator) -
The standard way to give the address of any resource on the Internet that is part 
of the World Wide Web (WWW). A URL looks like this: 

a .. http://www.ccoptimizers.com/request.htm 
b .. or telnet://well.sf.ca.us 
c .. or news:new.newusers.questions 
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World Wide Web - WWW - W3 -
The name given to the collection of computers which serve information in 
hypertext format to the INTERNET (J.W. Hohman, personal communication 
September 8, 2000). 

WWW (or web)(World Wide Web)-
Two meanings - First, loosely used: the whole constellation of resources that 

can be accessed using Gopher, FTP, HTTP, telnet, Usenet, WAIS and some 
other tools. Second, the universe of hypertext servers (HTTP servers), which are 
the servers, that allow text, graphics, sound files, etc. to be mixed together (J.W. 
Hohman, personal communication September 8, 2000). 
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Chapter 2 

REVIEW OF SELECTED LITERATURE 

Introduction 

New technology allows us to access more information, as well as giving us 

the potential to change the traditional role of teachers, who will be able to shift 

their educational interest from imparting knowledge to other aspects of the 

teaching and learning processes (Abingdon, Baille, and Percoco, 2000). 

Information technologies can help with many learning problems and allow 

teachers themselves to spend more time exploring new ways to teach their 

subject, giving individual attention to student learning, but it is important to 

identify optimum conditions for the use of information and communication 

technologies (Abingdon, Baille, and Percoco, 2000). 

The review of literature was divided into two major sections. The first 

section was dedicated to the benefits of technology in the classroom. The 

second and final section examined what types of technology can be used in the 

classroom. 

Benefits of Technology 

There seems to be clear and widespread agreement among the public 

and educators that students need to be proficient computer users. Students 

need to be able to use computers flexibly, creatively and purposefully. There are 

many skills students need to be "computer literate". In other words student need 

to see a purpose, have a direction, and be able to evaluate their use of the 

computer, multimedia programs and equipment, as well as the Internet 

(Eisenberg and Johnson, 1996). 

Teachers should be motivated to learn and incorporated technology 

because of the benefits it offers to students (Orwig, 1997). "When young children 
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see adults reading or writing, they imitate the action. The same goes for 

computers" (Haughland and Shade, 1997, p.23). 

Day (1996), in his article, "The Technology Generation," claims "Children 

are motivated to play games and use computers, because of the high level of 

interactiveness. They learn to make quick decisions in order to stay in charge. 

However, students in traditional classrooms make only one decision every half­

hour. In order to keep students motivated in the classroom, there must be an 

incorporation of the interactive world in which they live" (p.36). 

Students should be able to retrieve important information efficiently. 

Retrieving information from the Internet, Encarta, or CD-ROM requires some 

technical know how. Also there need to be skills for determining creditability and 

reliability of the sources. A learner must be able to glean through the source 

specific information to find appropriate facts. These skills prepare students for 

researching information (Eisenberg and Johnson, 1996). 

The computer restructures problems and shifts learning to analysis and 

synthesis. Also, it can create a deeper, intuitive understanding of things (Molnar, 

1997). With the advancement of technology the focus of learning can move from 

the rote mode into complex experiences. More will be expected from the 

students as technology makes exploring higher level reasoning possible, writing 

more efficient, and information easier to retrieve (Hancock and Betts, 1994). 

Project oriented education is an innovative way to bring inquiry-based 

learning into the school setting. An example of this was when Robert Tinker and 

his staff developed the National Geographies KidsNet, which allowed students to 

perform experiments related to acid rain and water quality. Students gathered 

data and analyzed trends and patterns of a scientific, social, and geographical 

nature. Scientists were than provided with data and findings by e-mail. In many 

instances the children's discoveries found water and air pollution beyond 
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acceptable standards. According to teachers, this activity increased the 

classroom time spent on Science and the interest shown by students (Molnar, 

1997). 

Internet can expand the classroom to include any geographical location in 

the world. Tight budgets make field trips difficult to arrange, but the Internet can 

help move students beyond the classroom walls (Winans, 1996). 

Computer offers structured learning experiences. Students take on 

responsibility of learning. They can now create and maintain web pages with 

programs for other learners (Orwig, 1997). Well-trained teachers with Internet 

training should be able to guide students on WebQuests or use the Internet to 

retrieve current information related to topics of study in the classroom. Also, 

students can copy pictures for reports, historical purposes, or to incorporate into 

their own web page. 

The ability of teachers and students to be on-line for extended periods 

may mean that content will be covered more deeply and rapidly then ever before. 

On-line schools may empower students to guide their own learning (Withrow, 

1997). Students in small communities now have access to classes previously 

nonexistent, because of cost. Now children can communicate via satellite or 

through the Internet with foreign language teachers (Hancock and Betts, 1994). 

Network projects "permit teachers to become consultants rather than 

lecturers" (Molnar, 1997, p.57). Technology presents education with a new 

model of learning. The roles of students, teachers and schools are changing. 

Teachers are no longer the sole information source. Instead, they help students 

gather, judge, organize, and present information. Teachers become a mentor or 

guide rather than the only knowledge source (Day, 1996). 

There will also be a larger reliance on technology for work and education. 

Modern computers and telecommunications generate rapid movement of money, 
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goods and services, and cause interdependence among the world's economies. 

In order for a country to remain competitive it must have a well-educated work 

force (Molnar, 1997). Winans (1996), in his article, Cover Story: Techno--hype or 

help?, states teachers must "prepare students for the hi-tech workplace. For 

example, seventh grade science teacher David Goodkin's students are using the 

same software program to make presentations as adults who work at Hughes 

Aircraft. Some kids would not make it in a traditional pen-and-pencil school 

setting. Students can now use imagination and have pride in a finished product" 

(p. 5). 

Network projects permit students to participate in experiments that involve 

real scientific problems with social significance. Students create maps displaying 

local measurements with the aid of technology. These projects enlist scientists 

and encourage them to communicate with students and direct them to 

information sources not readily available in the classroom. Thus, computers and 

telecommunications create a global classroom with social significance (Molnar, 

1997). 

The volume of new information is growing exponentially making basic 

knowledge and skills obsolete in some fields. Memorizing information does not 

mean the learner understands or knows how to use this information effectively. 

Instead of memorizing information, accessing and knowing how to use the 

information is the trend. It is estimated that since World War II the power of the 

computer has doubled 32 times. Also, the rate of computer advancement is not 

showing signs of slowing (Withrow, 1997). "The growth and exploitation of 

information rests not only upon the ability of scientists to produce new 

knowledge, but upon society's capacity to absorb and use it" (Molnar, 1997, 

p.58). 
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Education has changed from an orderly world of courses and disciplines to 

a world in which communication technologies are increasingly important. Even 

so, education is not changing fast enough. A restructuring of social, industrial, 

and educational institutions is anticipated in society's future (Molnar, 1997). 

"There is certainly reason for confidence that telecommunications 

technologies will expand and improve education over the next 25 years. If 

present trends continue, it seems not unreasonable to expect that digital 

technologies will have an impact on America's classrooms proportionate to that 

of writing and the printing press" (Withrow, 1997, p. 61 ). 

"Technology increases productivity but requires a more highly skilled work 

force with a broader education and a greater familiarity with the tools and 

theories of science. Competitiveness depends not only on the discovery of new 

innovations, but the speed at which that knowledge is transmitted through 

America's educational systems to create highly skilled workers who can apply 

knowledge" (Molnar, 1997, p. 57). For all children to master the skills needed to 

thrive in an information rich future, teachers must be supportive with technology 

skills, provide well designed projects, and determine effective assessments 

(Eisenberg and Johnson, 1996). 

Students who have online access perform better in the classroom (Center 

for Applied Special Technology, 1997). A nationwide study compared the work 

of 500 fourth and sixth grade students, comparing those who were online with 

those who were not. Those who had access to online resources showed 

significantly higher scores in the areas of information management, 

communication and presentation of ideas. It was also noted that those students 

using online technology were able to find material more quickly and use a wider 

variety of sources in their research. Teacher's behaviors changed as well during 

the course of this study. Those teachers who had access to online technology 
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( showed over the course of the study an increase in their time spent allowing the 

students to use technology. This suggested teachers' ideas of how technology 

can be used in the classroom have been modified. 

Enthusiasm for learning as well as an increased sense of independence 

among the students is another positive that comes from using technology in the 

classroom. In a case study by Oliver, Malm, Malone, Nay, Saunders and 

Thompson (1997), a mid-western suburban community was given access to the 

Internet and integrated it into the curriculum. It was shown that students 

displayed a great deal of enthusiasm when seeking to complete research on 

assigned topics. A majority of the students in this study were actively engaged in 

the discovery of information for their topic for an extended period of time. 

Students also displayed the ability to work independently and only use the 

teacher as a reference for questions regarding the computer as opposed to the 

teacher being a source in creating their final project. It was summarized that the 

Internet when used properly can be used to accommodate differing learning 

characteristics of students. 

Nevertheless, in spite of the potential advantages, these educational 

benefits are difficult to quantify. In a study carried out at the Imperial College in 

March of 2000 the researchers looked at the use of technology in teaching a 

specific content area. They examined the advantages and disadvantages of 

using technology to teach engineering education. Students and professors 

polled were asked five closed questions and six open questions. The survey 

results, indicate that, although there are many advantages in the use of 

computers in teaching and learning, there are many difficulties for lectures in 

using the new technologies because of logistical problems such as like lack of 

time, technical support and appropriate software (Abingdon, Baillie and 

Percoco, 2000). 
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( A case study by O'Hara (1998) showed several interesting findings. The 

first was students are not intimidated by technology. The students were actually 

found to be empowered by the use of the Internet. They were empowered to 

further utilize technology. The second findings of the study dealt with the fact 

that the students remembered what was done previously with the technology 

they had used. When asked six months after the initial project using the Internet 

the students were able to recall the events that took place. A major benefit of 

using the Internet is the wide range of choices available to the user when trying 

to complete a task involving research. The students also recalled their 

appreciation for the fact the aspect of choice had been built into their assignment. 

Technology is now making skills learned in school more relevant to the job 

market. According to Holt (1998): 

New advances in technology, most notably the Internet but also 

CD-ROMs made better software, are converging with the changing 

concepts of education and shifting priorities in the labor market to 

make computers a staple for nearly every grade and subject. Along 

the way, computers are changing the typical classroom from a 

traditional factory-like model into something more open, flexible, 

and self guided, with multiple sources of information and authority. 

(p.1) 

Holt (1998) quotes Gerkey as backing this assessment with the realization 

that employers want the students that have these skills. As more and more jobs 

are centered, not around a factory, but rather around jobs where the workers 

must juggle several tasks at once along with being self-motivated and self­

sufficient (as cited in Holt, 1998). 

The problem this brought to the surface was that there is unequal access 

to technology in the schools. Few schools have the resources to ensure they are 
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on the cutting edge of technology, therefore these schools may not be offering 

students what they need to succeed in the workplace. Of the school districts that 

do buy technology, many of them buy equipment not suited to their needs. This, 

too, affects the students negatively (Holt, 1998) 

In a 1990 study done by Chang and Osguthorpe they examined the 

effects of computerized picture-word processing on kindergartner's language 

development. In this study the authors looked at kindergartners who have had 

access to a computer software program that allowed them to connect words with 

pictures. The program had pictures, which had words and phrases matched up 

to corresponding pictures. Once the students can make the connection between 

the pictures and the words they can make sentences using the pictures and 

words. 

The control group had no access to the computer program. The 

experimental group was given 15 minutes a day, four days a week for six weeks 

with high school tutors to assist them in learning and operating the software. 

The results showed that the students who had access to the computer 

program did better than the control group on every part of the Woodcock 

Reading Mastery except Letter Identification. This was attributed to the reduced 

stress put on letter recognition and the focus put on sight words. 

The research presented shows many advantages to using technology for 

learning. Technology when used properly can open up huge amounts of 

knowledge to students. It also creates situations that can help students use 

higher level thinking skills to deepen there understanding of the content. The 

main drawback of technology is the amout of training required to effectively use 

it. 
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Types of Technology 

"The use of technology in schools has passed the point of no return" (Li, 

1998, p. 7). Computers do not create or replace the teacher, but teachers can 

become more effective with the proper use of technology. Integration of 

computers saves time in editing, produces professional looking documents, and 

gives students a hands on experience. Technology also plays a role in preparing 

students for future computer oriented careers. Special equipment can be used to 

facilitate children with learning disabilities. Students with reading or visual needs 

can use taped books and computer animated books to aid in reading 

comprehension (Li, 1998). 

Technology is a part of society and aids people in many ways. If one 

asked the average ten-year-old to describe home, he/she would likely include 

comments about having televisions, telephones, and an answering machine. This 

young adolescent would know what she wanted to watch on television and how 

to work the VCR. From the age of two or younger children have been 

manipulating these technologies. In more than 50% of American homes juveniles 

would also describe a computer. School must reflect the real world setting. The 

purposes of schools are to prepare children for the job market and teach 

students about society. Technology is the mechanism used in the American 

society today to achieve these goals (Withrow, 1997). 
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"In too many schools, most teachers and students still use computers only 

as the equivalent of expensive flash cards or electronic worksheets. The 

productivity side of computer use in the general content area curriculum is 

neglected or grossly underdeveloped" (Eisenberg and Johnson, 1996, p. 1). "A 

key obstacle to the use of technology in schools is the limited support teachers 

have for integrating unfamiliar technologies into instruction. As a result, teachers 

frequently avoid new technologies or use them for purposes other than those for 

which they were designed" (Hancock and Betts, 1994, p. 24). 

However, there are some encouraging signs concerning computers 

and technology in education. It is becoming increasingly popular for educational 

technologists to advocate integrating computers into the content areas. 

Computer skills taught in isolation, or in separate "computer classes" do not 

really help students learn to apply computer skills in meaningful ways according 

to some teachers and administrators. Successful integrated programs need to be 

designed around collaborative projects jointly planned and taught by teachers, 

library media professionals, and computer teachers. (Eisenberg and Johnson, 

1996). 

According to Reese (1999), an educational technology specialist, 

"Hypermedia is a tool to help students communicate and convey information to 

their peers. It allows students to be creative and take an active role in the design 

and creation process, which helps them in the learning process. There are 

important skills students can learn from creating hyperstack. They have to 

choose their subject, identify their audience, plan their stack and then create 
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appropriate visuals for it. All of these tasks help students learn new skills as well 

as to become active learners." (pg. 1) When properly used hypermedia allows 

for collaborative learning, and multi-media experiences. Students can begin the 

process of making sense of the data in the world around them, guided by the 

teacher, rather than having the teacher offer the data and how to make sense of 

it. 

The Internet is having a powerful impact on our society, but its role in 

education is just beginning to be developed. One question is of particular 

interest to educators: If students can gather information on such an immense 

variety of subjects, what happens to the teacher's role in a classroom? 

Hemenway (2000) conducted a random survey of 150 California high schools to 

develop a list of teachers who use the Internet concurrently with classroom 

instruction at least once a week. Follow up telephone interviews were conducted 

with 25 teachers to assess the classroom structure that has developed since the 

introduction of the Internet as a tool for learning. 

The report painted a picture of a continuum of change that ranged from 

classroom atmosphere to simple changes in the students' attitude towards 

learning. An un-named English teacher was quoted as saying, "Kids find using 

the Internet more fun, engaging in learning, and they are comfortable at it. They 

use it at home already ... They are more motivated, and have creative choices" 

(As cited in Hemenway, 2000). 

Teacher-created web pages available on the Internet can help simplify 

communication with parents. A well-designed class web page can serve a 

15 



variety of purposes. It can provide a description of the classroom, a general 

outline and time line of units, specific information about individual units or 

projects or information on individual student progress. (Johnson, 2000). 

Summarv 

Our nation's schools are rapidly acquiring both computers and network 

infrastructures. National Center for Educational Statistics reported that between 

1989 and 1992 schools' inventory of computers increased nearly 50%. In 

addition, surveys have confirmed the increasing prevalence of the Internet and 

other online services in schools. Using computers in the classroom can have 

many positive impacts on both student and teacher. 

Computers can be used to motivate students and make learning more 

relevant to real world situations. Computers help students shift their learning to a 

much deeper level by giving them a way to retrieve a wide range of information 

on any subject. Internet allows teachers to expand the classroom to any location 

in the world. 

Conclusion 

Research discussed in my review supports the use of computers in the 

classroom. Teachers have a responsibility to prepare students for the high tech 

job market they will be entering. Using computers and other technology to 

facilitate the learning which takes place in the classroom does this. When 

students are given an opportunity to use technology in this way they are taking 

the knowledge they have learned and applying it to real world situations. 
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Research also cautions us about the limitations of technology such as 

high costs and availability of technical assistance. Technology will never replace 

teachers. Technology will allow good teachers to enhance and deepen the 

education that students receive. 
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Introduction 

CHAPTER THREE 

DESIGN OF PROJECT 

It has been shown that using computers to enhance learning is an 

effective tool in education. When students use technology to strengthen their 

understanding of content area learning as opposed to traditional teaching 

methods, it creates a situation, which more closely resembles that of the modern 

workplace. Traditional classrooms, which do not use technology as a tool to 

enhance and deepen learning, have students who lack skills needed in the 

contemporary job market. 

I chose to do this project because I saw our very expensive computer lab 

being used only for word processing skills. I also needed to find a way to make 

content area more meaningful to the students. Finally, I wanted to increase the 

communication between the parents and myself without having to rely on the 

students as the middleman. 

I found the use of a classroom web page was of great benefit to all parties 

involved. The students reported that they were proud of their work and were 

eager to continue the web page. I had many parents comment on the 

effectiveness of the web page as a communication tool. 
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Procedure 

This project targeted fourth grade teachers who wanted to find a way to 

integrate technology into their classroom in a meaningful way. The procedure 

used in creating this handbook was the creation of age appropriate lessons and 

activities which would take the students and teachers step by step through the 

creation of a classroom web page. The manual includes four sections: 

Section One: policy that the teacher will need to be aware of when 

creating a classroom web page. For the policies involving the use of students' 

pictures and names as well as the Internet Usage Agreement I used the 

Stanwood School District existing guidelines in each case. 

Section Two: lesson plans for setting up a classroom web page. The 

lesson plans were based on my own experience in creating a web page and then 

making those steps age appropriate. 

Section Three: a copy of the classroom web page and other web sites that 

would be helpful in creating your own classroom web page. I found these web 

sites by looking through various searches on the Internet and then looking at 

each one to make sure they were age appropriate and had something unique 

about them. 

Section Four: a list of resources used in the creation of this manual. 

These resources helped in creating the step by step procedure used in this 

handbook. 
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CHAPTER4 

THE PROJECT 

"A Handbook for Creating a Fourth Grade 

Classroom Web Page" 

Written By 

John R. Getzinger 

Utsalady Elementary School 

Stanwood-Camano School District 



INTRODUCTION 

Often times schools spend thousands of dollars on computers and the 

newest technology for their students' use and have very little to show for their 

investment. All to often those computers and technologies go unused by 

teachers and students for many reasons. One of the big reasons they are not 

used for much more than glorified typewriters is the lack of instruction the 

teachers have in making the use of the technology meaningful to the students. 

p-ii 

Not only can these technologies help the students have a deeper 

knowledge of their learning, it can also help their parents have a sense of what is 

going on in the classroom. By creating a classroom web page the teacher and 

his/her students can showcase what it is they are learning about in the classroom 

as well as communicate important information in a medium that many parents 

have access to. 

This project is a first step in allowing students to use technology to deepen 

their understanding of what it is they are learning in the classroom about 

individual subject matter as well as introduce them to using computers and 

technology to do more then they thought possible in a classroom setting. 

Genuine, regular, real-time collaboration with parents can make positive 

differences in a child's learning experiences, but the communication and planning 

needed to create this collaboration takes time. Teacher and student created web 

pages available online can simplify communication and planning efforts 

(Johnson, 2000). 



( 

p-iii 

Doug Johnson a parent describes his experience with Teacher Web pages as 
the following: 

When my son Brady was in the fifth grade, he came home with a 
report card that was, shall we say, less than impressive. This bright hard­
working boy was getting D's in school. The first parent-teacher 
conference of the year was held 10 weeks after school began, and it 
wasn't until then that I learned of the problem. 

Parents of children with work completion problems can become 
allies in helping these children manage their time and turn in quality work. 
Answers to questions about class rules, policies, and supplies should be 
readily available. 
Teacher created web pages available on the Internet can help simplify 
communication and planning efforts. Sure, most if not all of this 
information is made available through printed materials sent home with 
student and through earlier, more regularly scheduled face to face 
conferences. Conferences are difficult to schedule and are real time 
eaters. The Web can help overcome these problems. (Johnson, 2000) 

A well-designed class Web page can serve a variety of purposes: 

• Providing a general description of the classroom or course 
• Providing a general description of units covered 
• Providing a general outline and time table of units 
• Providing specific information about individual projects 
• Providing real time information about the progress of individual students 

(Johnson,2000) 

That's a lot of information that as a parent I would love to have. Just think. 
Junior comes home, plopping on the sofa with remote in hand. "How's the 
homework situation?" you ask. "Under control. Got it done in study hall," 
replies Junior. You double-check by logging on to the class Web page, 
enter your personal username and password, and find that Junior has 
been missing daily assignments and did not do well in the last test. Ah, 
something to talk about at suppertime. (Johnson, 2000) 

As a savvy consumer, on what will I base my choice of school? 
Convenience, of course. But I will also want to be sure the 
teachers in my son's school communicate well, are organized, and 
see me as a valuable partner in his education. As important as a 
good education is to his future, I can do nothing less. Schools can 
take an active role in making parent consumers aware of quality of 
their teachers and programs by having useful, informative, 
professional class Web pages( p. 48-51). 
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Creating and maintaining a web page can be a lot of work for a teacher. 

That is why I felt that students should be involved in the process. In the following 

handbook you will find out how to create a web page. There are five classroom 

tested lesson plans to use with your fourth grade students. I hope that your class 

finds the creation of a web page as valuable as mine did. If you have any 

questions feel free to contact me at Utsalady Elementary. 
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Definition of Terms 

E-mail (Electronic Mail) -
Messages, usually text, sent from one person to another via computer. E-mail 
can also be sent automatically to a large number of addresses (J.W. Hohman, 
personal communication September 8, 2000). 

HTML-

P-1 

Hyper Text Markup Language the text markup language used to insert tags 
which allow a Web browser to correctly display a hyper-text document. HTML 1, 
HTML +, HTML 2 and HTML 3 are versions of HTML in use at this time. HTML is 
a subset of the Standard Generalized Markup Language (SGML) first invented to 
display legal texts and now the world standard for large documentation projects 
(J.W. Hohman, personal communication September 8, 2000). 

Internet-
The vast collection of inter-connected networks that all use the TCP/IP protocols 
and that evolved from the ARPANET of the late 60's and early ?O's. The Internet 
now (January 1996) connects roughly 75,000 independent networks into a vast 
global network (J.W. Hohman, personal communication September 8, 2000). 

Multimedia -
Documents which contain text, sound, graphics and video elements that are all 
capable of being displayed to the user (J.W. Hohman, personal communication 
September 8, 2000). 

Network-
Any time you connect 2 or more computers together so that they can share 
resources, you have a computer network (J.W. Hohman, personal 
communication September 8, 2000). 

URL (Uniform Resource Locator) -
The standard way to give the address of any resource on the Internet that is part 
of the World Wide Web (WWW). A URL looks like this: 

a .. http://www.ccoptimizers.com/request.htm 
b .. or telnet://well.sf.ca.us 
c .. or news:new.newusers.questions 

World Wide Web - WWW - W3-



the name given to the collection of computers which serve information in 
hypertext format to the INTERNET (J.W. Hohman, personal communication 
September 8, 2000). 

WWW (or web)(World Wide Web) -
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Two meanings - First, loosely used: the whole constellation of resources that can 
be accessed using Gopher, FTP, HTTP, telnet, Usenet, WAIS and some other 
tools. Second, the universe of hypertext servers (HTTP servers) which are the 
servers that allow text, 
graphics, sound files, etc. to be mixed together (J.W. Hohman, personal 
communication September 8, 2000). 
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Internet Acceptable Use Policy Agreement 

You will need to have your students and their parents/guardian complete 

an Internet Acceptable Use Policy Agreement. This agreement protects the 

teacher and the school district from being held liable for inappropriate use of the 

Internet by students. This also gives students and parents clear guidelines for 

what is and is not acceptable use of the district's Internet capabilities. Both the 

student and the parent will be required to review and sign this form before the 

student is allowed to use the Internet at school or in the district. 
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Please read this document carefully before signing. Internet access is now available in 
the Stanwood ·school District. We are very pleased to have Internet access, as we believe 
it offers valuable, diverse and unique resources to both students and teachers. Our goal 
in providing this service is to promote educational excellence in the district by 
facilitating resource sharing, innovation and communication. For those not familiar 
with the term, the Internet is an 'electronic highway• connecting millions of computers 
all over the world and millions of individual users. Access to the Internet will enable 
students to explore thousands of libraries and databa~!!S throughout the globe. In addition, 
the system will be used to increase school and District communication, enhance 
productivity and assist employees in upgrading their skills through greater exchange of 
information with their peers. The system will also assist us in sharing information 
with the local community, including parents, social service agencies, government 
agencies, and businesses. With access to computers and people from around the world 
also comes the availability of material that may not be considered to be of educational 
value in the context of the school setting. Families should be warned that some material 
obtained via the Net may contain items that are illegal, defamatory, inaccurate or 
polentially offensive. We have taken precautions to restrict access to controversial 
mz.teriais. However. on a global network it is impossible to control all materials and an 
inciustrious user may discover controversial information, either by accident qr 
deliberatety. We firmly believe, however, that the benefits to students from online 
acc:ess outweighs the possibility that users may procure material that is not consisteni 
witli our educational goals. The purpose of this agreement is to ensure that use of 
ln1E1rnet resources is consistent with our stated mission, goals, and objectives. The 
smooth operation of the network relies upon the proper conduct of the students and 
faculty who must adhere to strict guidelines. These guidelines are provided here so that 
you are aware of the responsibilities you are about to assume. If a user violates any of 
these provisions, his or her account will be terminated and future access could be denied 
in o)CCordance with the rules and regulations discussed with each user during Internet 
training sessions._ To gain. access to the Internet, all students under the age of 18 must 
obtain parental permission and must have their Internet Driver's License signed by a 
parent or guardian. This license was issued during our Internet Training Sessions and 
must be signed in order to be valid. The signature(s) at the end of this document is 
(are) legally binding and indicate(s) the party (parties) who signed has (have) read the 
terms and conditiof}S carefully and understand(s) their significance. 
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The Board of. Directors recognizes that the district is implementing an electronic communications system (network 
that will allow unprecedented opportunities for students, staff and patrons to communicate, learn, access and publisl: 
information. The Board believes that the resources available through this network and the skills that students will 
develop In using it are of significant value in the learning precess and student success In the future. These new 
opportunities also pose many new challenges including, but not llmited to, access for all students, age-level 
appropriateness of material, security and cost of maintaining ever more elaborate systems. The District will endeavor 
to ensure that these concerns are appropriately addressed, but cannot insure that problems will not arise. By creating 
this network, the Board intends only to provide a means for educational activities and does not intend to create a first 
amendment forum for tree expression purposes. The district dedicates the property comprising the network, and 
grants access to it by users~· only for the education.al activities authorized under the policy and procedures and under 
the specific limitations contained therein. The Board directs the Superintendent to provide training and procedures that 
encourage access to electronic information systems and networks by students, staff and patrons while establ' 1g 
reasonable controls for the lawful, efficient and appropriate use and management of the system. 
Cross References: Board Policy · 

Adoption Date:031897 

2311 Selection & Adoption of Instructional Materials 
2312 Copyright Compliance 
3300 Corrective Actions or Punishment 
5255 Disciplinary Action and Discharge 

Stanwood School District #401 Board Policy 2314P (Procedures) 

INSTRUCTION 
Electronic lnforma1tion System (Networks) Acceptable Use Guidelines 

Network 
1 . A use of the system must be in support of education and research and consistent with the mission of the 

district. District reserves the right to prioritize use and access to the system. 
2. Any use "of the system must be in conformity to state and federal law, network provider policies and licenses, 

and districJ policy. Use of.the. system for .commercial solicitation is prohibited. Use of the system lor · 
charitable purposes must be approved in advance by the superintendent or designee. 

3. The system constitutes public facilities and may not be used to support or oppose political candidates or ballot 
measures. 

4. No use of the system shall serve to disrupt the operation of the system by others; system components including 
hardware or software shall not be . destroyed. modified or abused in any way. 
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5. Malicious use of the system to develop programs that harass other users or gain unauthorized access to any 
computer or computing system and/or damage the components of a computer or computing system is 
prohibited. 

6. Users are responsible for the appropriateness and content of material they transmit or publish on the system. 
Hate mail, harassment, discriminatory remarks or other anti-social behaviors are expressly prohibited-

7. Use of the system to access, store or distribute obscene or pornographic material is prohibited. 
8. Subscriptions to mailing lists, bulletin boards, chat groups and commercial on-line services and other 

information services must be pre-approved by the superintendent or designee. 
9. Network guideline items 1-8 above apply to all internal and external use of the system. Persons accessing the 

system externally, by calling in, will observe the same guidelines as persons using the system from within. 

Security . 
1 o. System accounts are to be used only by the authorized owner of the account for the authorized purpose. Users 

may not share their account number or password with another person or leave an open file or session 
unattended or unsupervised. Account owners are ultimately responsible for all activity under their account. 

11. Users shall not seek information on, obtain copies of, or modify files, other data or passwords belonging to 
other users, or misrepresent other users on the system or attempt to gain unauthorized access to the system. 

12. Communications may not be encrypted so. as to avoid security review. 
1 3. Users should change passwords regularly and avoid easily guessed passwords. 

Personal Security 
14. Personal information such as addresses and telephone numbers should remain confidential when communicating 

on the system. Students should never reveal such information without permission from their teacher or other 
adult. 

15. Students should never make appointments to meet people in person that they have contacted on the system 
without district and parent permission. 

16. Students should notify their teacher or another adult whenever they come across information or messages that 
are dangerous. inappropriate or make them feel uncomfortable. 

'Copyright 
17. The unauthorized installation. use, storage or distribution of copyrighted software or materials on district 

computers is prohibited. 

General Use · 
1 B. Diligent effort must be made to conserve system resources. For example, users should frequently delete E-mail 

and unused files. 
1 9. No person shall have access to the system without having received appropriate training, a signed Individual 

User Release Form must be on file with the district. Students under the age of 18 must have the approval of a 
parent or guardian. 

2 0. Nothing in these regulations is intended to preclude the supervised use of the system while under the direction 
of a teacher or other approved user acting in conformity with district policy and procedure. From time to 
time, the district will make a determination on whether specific uses of the system are consistent with the 
regulations stated -above.· Under prescribed circumstances, non-student or staff use may be permitted provided 
such individuals demonstrate th.at their use furthers the purpose and goals ol the district. For security and 
administrative purposes the district reserves the righl for authorized personnel to review system use and file 
content. The district reserves the right to remove a user account on the system to prevent lurther 
unauthorized activity. The district's wide-area network provider (WEdNet) reserves the right to disconnect 
the dislricl to prevent further unauthorized activity. Violation of any of the condilions of use may be cause fer 
disciplinary action . 

.A'1option Oate:031897 
( 

R~vS.98 
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Internet • Terms and Conditions 
Acceptable Use Guidelines for Stanwood School District 

1) Students are responsible for good behavior on the school computer networks, just as they are in a 
classroom or a school hallway. General school rules for behavior and communications apply. 

2) The network is provided for students to conduct research and communicate with others. Access to 
network services is given to students who agree to act in a considerate and responsible manner. 
Access is a privilege - not a right. That access entails responsibility. Inappropriate use will result in 1\ 

suspension or cancellation of Internet privileges. The system administrators will deem what is 
inappropriate use arid their decision is final. Also, the administrators may close an account at any time 
as required. The administration, faculty and staff may request the system administrator deny, revoke 
or suspend specific user accounts. 

3) Users are expected to abide by their generally accepted rules of network etiquette and conduct 
themselves in a responsible. ethical and polite manner while online. 

4) Users are not permitted to use the computing resources for commercial purposes, product 
advertising, political lobbying or political campaigning. 

5) Users are not permitted to transmit, receive, submit or publish any defamatory, inaccurate, 
abusive, obscene, profane, sexually oriented, threatening, offensive or illegal material. 

6) Physical or electronic tampering with computer resources is not permitted. Damaging computers, 
computer systems or computer networks intentionally will result in cancellation of privileges .. 

7) Users must respect all copyright laws that protect software owners, artists and writers. 
Plagiarism in any form will not be tolerated. 

8) Security on any computer system is a high priority, especially when the system involves many 
users. If you tee/ you can identity a security problem in. the school's computers, network or Internet 
connection, you must notify a system administrator. Do not demonstrate the problem to others. Using 
someone eh;e's password or trespassing in another's folders, work or files without written permission 
is prohibited. Attempts to log on to the Internet as anyone but yourself may result in cancellation of 
user privile£1es. 

9) Stanwood School District makes no warranties of any kind, whether expressed or implied. for the 
service it is providing. We assume no responsibility or liability tor any phone charges, line costs or 
usage fees, nor tor any damages a user may suffer. This includes loss of data resulting lrom delays. 
nondeliveries, mis·deliveries or service interruptions caused by its own negligence or your errors or 
omissions. Use ot any .information.obtained via the Internet is at your own risk. We specifically deny 
any responsibility for the accuracy or quality ot information obtained through its services. 

1 O) All commuoication and information accessible via the computer resources shall be regarded as 
private property. However, people who operate the system may review files and messages to maintain 
system integrity and insure that users are using the system responsibly. Messages relating to, or in 
support of, illesal activities may be ·reported to the authorities. Any violations may result in a loss of. 
computer access. as well as other disciplinary or legal action. Users are considered subject to all local, 
state and federal laws. 
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USER SECTION 

Dr. RA YMONP P. REID, Superintmdmt 
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I have read the District Internet Use Agreement. I agree to follow the rules contained in this Policy. its procedures and 
the Acceptable Use Guidelines. I understand that if I violate the rules my account can be terminated and .1 may lace 
other disciplinary measures. 

User Name (please pri~t} 

_ Staff _ Student Student No. 

Current Grade 

School 

User's Signature: 

Date: 

PARENT OR GUARDIAN SECTION 

As the parent or legal guardian of the student signing above, I have read this Internet Use Agreement and grant 
permission for my son or daughter to access the Internet. I understand that the district's computing resources are 
designed for educational purposes. I also understand that it is impossible for Stanwood School District to restrict 
access to ·a11 controversial materials and I will not hold them responsible for materials acquired on the network. I 

• .understand that individuals and families may be held liable for violations. Furthermore, I accept full responsibility 
for supervision if and when my child's use is not in a school setting. 

Parent Signature 

Date 

Parent Name (please print) 

Home Address 

Phone 

Trainer Signature: 

Date: 

--------·-----------~------------------

This space reserved for System Administrator 

Assigned User Name: 

Assigned Temporary Password: 

Rt1v5.SB 
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Model Release Form 

The model release form needs to be completed by a student's 

parent/guardian before that student's picture can be used on the Class Web Site. 

The school district only allows for the student's first name to be shown in print. 

This form releases the school district from the liability associated with using a 

student's picture on your Class Web Site. 
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MODEL RELEASE 
.. ,.. .......... _ .. 

I, as legal parent/guardian, Student's name ----------------
hereby authorize and give rull con­
sent :to photographers emp Joyed by/ 

representing -----..,---.,---,­
Schoo I Dis tr'i ct and/or its schoo Is, Parent/guardian signature -------

Phone Date 

or community news media, to photograph 
my chi Id/ward- I further give my con­
sent to said photographer or his/her 
assignees or licensees to publish, 
reproduce or use said photographs in' 
·any ·manner or form in any medium for 
the purpose of illustration, advertis­
ing, trade, pub! ication or display, 
without restriction or limitation or 
any compensation. 

------- ----------
Witness --------------------------------

• ·. 

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - ------

PHOTO USE REQUEST 

Attached is a contact print of your child/ward we plan to use in a: 

school district/school publication 

----school district/school display 

---- uther pub I ication 

display at 

If dS legal parent/guardian, you object to this use please notify us by 
(d.He) by telephoning: 

"'copy of this contact print has been filed with the model release form P-10 
you proviaed us. Thank you for your cooperation. 
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This questionnaire is designed to determine the accessibility of 
computers and the Internet to students in our classroom. 
Please fill this out completely. This will only be used for 
classroom purposes. 

1. Do you own a computer? ____ _ 

2. If you own a computer do you have Internet access 
available? ------

3. If you do not have a computer do you have access to one via a 
friend, family member, or at your work? ____ _ 

4. Does this computer have Internet access? ____ _ 

5. If you do have this type of access could you use said computer at 
least 2 times a week? ------

6. Would you be interested in viewing a web site designed in part by 
your student? __ _ 

7. Would it be helpful to you if this web site listed upcoming school 
events? -----

8. Do you have any experience in creating a web 
page? ____ _ 

9. If you do have experience would you be willing to help in our class 
to create a web page of our own? ___ _ 

Thank you for taking the time to fill out this survey. If you have 
any questions please call me at school. 



P-12 

Lesson# 1 

Internet Introduction 

Learner Outcome: The learner will be able to find a web site on the Internet 

using a URL with confidence. The student should be able to correctly find 8 of 1 O 

web sites copying them into the address bar of the browser from the worksheet. 

Materials: Computer with Internet access for each student or group of students, 
Internet Introduction Worksheet and a pencil. 

Purpose of the Lesson: This lesson is designed to show students how to find 
web sites on the Internet. It will also demonstrate the importance of inputting the 
correct keystrokes in the URL in order to find the desired site. 

Lesson: 
1. Have the students log on to the computers and have them access the 

Internet. 
2. Put a predetermined web site address on the white board and have the 

students input the site on the address bar of their browser. Then have them 
press return to get to the site. 

3. Several students will have input the wrong keystrokes and will not be at the 
desired site. Have those students re-enter the address until they get to the 
correct site. 

4. Discuss with the students the importance of typing in the correct keystrokes. 
This has illustrated to them that one wrong keystroke will not allow them to 
get to the site they desire. 

5. Pass out the Internet Introduction Worksheet, which the students will 
complete by following the directions. 

6. When the students have finished the worksheet go over it with them to make 
sure they did it correctly. For students who missed more than 20% of the 
questions have them redo the ones they missed until they get it correct. 

Assessment: Check worksheet and pass with 80% accuracy. 
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In order to get a web site on the Internet you must put in an "address" just like 
you need to know the address of a house in order to get to it. The address is a 
series of words and symbols, which tell the computer where it is you, want to go. 
If you do not But-in-t e correct address it is just like getting the wrong address to 
a friend's use ... y u won't get there! Be sure you enter the address into the 
address b r . the way it is shown on this paper. If you don't you could be 
in for a long ay. When you get to the web site after you put in the address 
describe what you see on the computer screen. That way I will know if you made 
it to the correct place. Good Luck 

1. http://www.cnn.com 
What do you see? 

2. http:l/stanwood.wednet.edu 
What do you see? 

3. http:l/www.espn.go.com 
What do you see? 

4. http:l/www.espn.go.com 
What do you see? 

5. http:l/www.echotree.com/glossarv.html 
What do you see? 

6. http://!www. museums.reading. ac. uk/children/#museums 
What do you see? 

7. http:l/www.kidscom.com 
What do you see? 
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8. http://web66.coled.umn.edu 
What do you see? 

9. http://www.sandbox.net 
What do you see? 

10.http://www.washinqtonprep.com 
What do you see? 

P-14 
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Lesson #2 

Evaluating Classroom Web Pages 

Learner Outcome: The learner will be able to evaluate other classroom web 
pages by describing what they like about a given site using the evaluation sheet 
provided for them. 

Materials: Computer with Internet access for each student or group of students, 
Web Page Evaluation Sheet and a pencil. 

Purpose of the Lesson: This lesson is designed to have the students explore 
other classroom web pages in order to determine what the student like about 
them and would possibly want to include in our class's web page. 

Lesson: 
1. Have the students log on to the computers and access the Internet. 
2. The students will then follow the directions on the Web Page Evaluation 

Sheet. This sheet will tell them where to go to find a registry of classroom 
web pages they can browse through to find things that they like and may 
possibly want to include in their class page. · 

3. After the students have filled out the majority of the space given for this 
exercise discuss with the students what it is that they liked about these sites 
in a whole class discussion. 

4. Come up with a list of ideas that the class can agree on for future 
consideration on putting them into the class web site. 

Assessment: Collect student's worksheets to check to make sure they did the 
activity. 
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Name=--------------------

Technology: Web Page Evaluation Sheet 

Date=---------------------

There are many schools and classrooms who have already made web 
pages. They are nicely tucked into the following web site. Your assignment 
today is to look at as many school/ classroom web sites as possible and 
write down your preferences and concerns when you peruse the pages. 
We will ultimately be making our own page and we need to know what we 
liked as a whole group. 

Bring up the following web site: http://web66.coled.umn.edu/ 
When you get to this site go to the Education section. You will see 
underneath that heading that there is a category called International 
Registiy of Schools on the Web., Double click on it. You will then come to a 
picture of the states. Double click on Washington. There will be 156 sites 
for you to look at just for elementary schools on the web. Once you have 
reached the listing click on the different schools and see what you like 
about how they have set up their web pages. Write your findings below. 
Make sure you include their web page address: 

School Web Address Preference (likes) 

1 . --------------------------------------------------

2. --------------------------------------------------

3. --------------------------------------------------
4. --------------------------------------------------
5. --------------------------------------------------
6. --------------------------------------------------
7. --------------------------------------------------
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Lesson #3 

Individual Page Brainstorming 

Learner Outcome: The learner will be able to, in a collaborative group, come up 
with a title and content of an individual page for the classroom web site. 

Materials: Web Page Evaluation Sheet from the previous lesson, Individual 
Page Brainstorming worksheet and a pencil. 

Purpose of the Lesson: This lesson is designed to give the students the basis 
of what will be included in their page of the class web site. 

Before the Lesson: You must come up with 4-7 individual pages one of which 
each collaborative group will be assigned to design. Some examples are a math 
page, a social studies page, a school lunch menu page, an upcoming events 
page, etc. 

Lesson: 
1. Have students get out their Web Page Evaluation Sheets they completed in 

the previous lesson. Have students review it to refresh their memory on what 
they liked about the web pages they have already seen. 

2. Give the students a topic on which their individual page will be based. 
3. The students will then follow the directions on the worksheet and come to 

some kind of agreement on what they want on their page. 
4. Have teams hand in one copy of the worksheet with their information on it. 
5. You will need to edit their ideas with each group individually and add or take 

away ideas according to your own judgement. 
6. Once you have done this with the teams you will need to collect a newly filled 

out worksheet from the team with all of the new ideas and information. 

Assessment: Check the worksheet as well as discuss with the team their ideas 
individually. 
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I ndiuidual Page Brain Storming 

Team Members 
Names. ______________________ _ 

Title of Page: __________ _ 

What do we want to include in this page? (types of 
information): ______________________ _ 

What graphics do we want to go with our 
information?: ______________________ _ 



( 
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Lesson #4 

Designing the Layout of the Individual Page 

Learner Outcome: The learner will be able to, in collaborative groups, draw a 
sketch of what their individual page will look like including graphic, buttons and 
text information. 

Materials: What My Page Will Look Like Worksheet, Brainstorming Worksheet 
from the previous lesson and a pencil. 

Purpose of Lesson: This lesson is designed to have the students draw out on 
paper what they want their individual page to look like. 

L,esson: 
1. Give the students the Brainstorming Worksheet from the previous lesson. 

Then pass out a What My Page Will Look Like Worksheet to each student. 
2. Have the students review the Brainstorming Worksheet and draw out exactly 

how they want their page to look on the web site. 
3. Have the groups collaborate on a final copy taking ideas from the entire 

group to come up with a final draft that will be used in making their page. 
4. When the teams have the final copy finished collect them and edit them for 

any glaring mistakes. 

Assessment: Check every student's worksheet to make sure all students have 
contributed. 



What My Page Will Look Like 
Sketch out what you want you page to look like including all of the information from 

your Brainstorming Worksheet. 
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Lesson #5 

Creating the Individual Pages 

Learner Outcome: The learner will be able to, with the help of the teacher, 
change typed documents and pictures into HTML files to be placed on a web 
site. 

P-21 

Materials: Computer with Internet Access and Claris Works Software, What My 
Page Will Look Like Worksheet, HTML Primer. 

Purpose of Lesson: This lesson is designed to have the students transform 
their documents and pictures into HTML files and place them on the web site. 

Lesson: 
1. Have the students type the information from the What My Page Will Look Like 

Worksheet onto the Claris Works word processing software. 
2. Have the students save the pictures that they have taken with a digital 

camera onto Claris Works word processing as well. 
3. Follow the directions from the HTML Primer to save the documents and 

pictures as HTML files. This should be done by the students with the 
teacher's assistance and supervision. 

4. Save the transformed documents and pictures onto the Claris Works Page 
Maker software and manipulate to suit your desired layout. This should be 
done by the student with the teacher's assistance and supervision 

Assessment: Help each group of students with this process until you are 
confident they can do it on their own. Have a quiz that has the student transform 
a picture and a document without the use of the HTML Primer. 
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To create documents that can be viewed by a World Wide Web (WWW) browser, you use the 
Hypertext Markup Language (HTML). HTML consists of a set of tags (formatting codes) added to 
text For example, if the text "Local News" is formatted as an 18 point header, the text looks like 
this: <H2>Local News<IH2> when translated to HTML. Text can also be tagged to create a 
hypertext links to other documents. You can use Claris Works to open, edit, and create HTML 
documents without having to be familiar with HTML tags. 

This document describes how to: 
• open (import) HTML documents so you can read and edit them as word processing 

documents 
• create word processing documents and save (export) them in the HTML format 

As you get started, please keep the following points in mind: 
• You should be familiar with the concepts and techniques for working with Claris Works 

word processing documents, stylesheets, and shortcut buttons. For more information on 
these topics, see the documentation that came with Claris Works. 

• Each WWW browser interprets HTML tags in slightly different ways. For example, some 
browsers may display a header in color in an elegant typeface, while a text-only browser 
may display the same header in capital letters in the same size and font as the rest of the 
document. The Claris Works HTML translator uses the default display styles for Mosaic, a 
browser created by the National Center for Supercomputing Applications (NCSA). For 

HTML Primer 



more information on NCSA Mosaic, visit the WWW site at: 
http://www.ncsa.uiuc.edu/SDG/Software/Mosaic 
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• The translator file is called "WWW [HTML]" and is installed. along with other translators, 
in the Claris Translators folder in the Claris folder (inside the System Folder). You don't 
use the HTML translator file directly. Instead, you use the Claris Works save and open 
commands to direct the file through the translator. 

CJ,"eating HTML documents 
This section describes how to create new HTML documents. For information on entering and 
formatting text in HTML documents, see the section "Formatting and editing HTML documents." 

Using stationery to create HTML documents 
The easiest way to create HTML documents is to start with the Claris Works HTML stationery, a 
template included with Claris Works 4.0. The stationery is a blank preformatted word processing 
document that you can reuse. 

To open the stationery document: 
I. Launch Claris Works by double-clicking the Claris Works icon. 
2. Choose New from the File menu. 
3. In the New Document dialog box, select Use Assistant or Stationery. 
4. Choose Internet from the pop-up menu, select WWW [HTML] Document, and then click OK. 

You see the blank, untitled stationery in its own window. Tiie original document remains 
unchanged, ready for you to use again. The stationery includes a set of HTML styles in the 
stylesheet palette and three shortcut buttons, "Make Hypertext Link," "Unordered List Item," 
and "Horizontal Rule." 

5. To open the stylesheet palette, choose Show Styles from the View menu. 
The styles include headers of various sizes as well as styles for normal, literal, and preformatted 
text. 

6. To display the shortcuts palette, choose Shortcuts and then Show Shortcuts from the File 
menu. 
For specific information about using the shortcut buttons to create HTML documents, see the 
sections "Hypertext links," "Lists," and "Horizontal rules." 

Note To make the buttons appear in the shortcuts palette for any ClarisWorks word 
processing document or text frame (not just in a stationery document): 
1. Launch Claris Works and open the HTML stationery by following Steps l-4, above. 
2 Choose Shortcuts and then Edit Macros from the File menu. 
3. Select Make Hypertext Link from the Macro pop-up menu and then deselect 

Document Specific. Do the same for Unordered List Item and Horizontal Rule. 
4. Click Done. 

The HTML stationery shortcuts now appear in the shortcuts palette for any word 
processing document. 

-------------··-------------------------------------------------------------------------------------------------------
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Creating HTML documents without using stationery 
If you prefer, you can create an HTML document in a regular word processing document instead 
of the HTML stationery. 

To open a word processing document: 
I. Launch ClarisWorks by double-clicking the Claris Works icon. 
2. Choose New from the File menu. 
3. In the New Document dialog box, select Word Processing and then click OK. 

Using the Claris Works HTML stylesheet or HTML shortcut buttons is optional. If you want to 
use the Claris Works HTML stylesheet, go on to the next step. If you want to use the HTML 
shortcut buttons, follow the steps in the Note in the previous section "Using stationery to create 
HTML documents." 

4. To import the HTML stylesheet into your blank document, choose Show Styles from the View 
menu. 

5. In the File menu on the stylesheet palette, choose Import Styles. 
6. Navigate to the Claris Works Styles folder in the Claris Works 4.0 Folder, select HTML Styles, 

and then click Open. 
7. In the Select Styles to Import dialog box, click Check All and then click OK. 

Saving documents as HTML files 
To save (export) a document as an HTML file: 
1. Choose Save As from the File menu. 
2. In the Save As pop-up menu, select WWW [HTML]. 
3. Navigate to the folder in which you want to save the file, type a file name, and click Save. 

To help you keep track of the file format of your documents, you can add extensions to the 
filenames, such as myfile.html for an HTML file, or myfile.cw for a Claris Works file. For best 
results with HTML files, don't use spaces in the filenames. Either remove spaces or replace. them 
with unde,rscores or hyphens. 

Important Be sure to keep copies of your documents in their original formats, especially 
HTML documents that you import. The translator does not provide a complete set of 
In!'ML tags and may replace some of the original tags. 

Opening HTML files 
To open (import) existing HTML files: 
I. Launch ClarisWorks by double-clicking the ClarisWorks icon. 
2. Choose Open from the File menu and then navigate to the HTML file you want to open. 
3. In the Document Type pop-up menu, select Word Processing. In the File Type pop-up menu, 

select WVvW [HTML]. (If you'd like see what the HTML codes in your text look like, select All 
Available or Text in the File Type pop-up menu.) 

4. Select the name of the file you want to open, and click Open. 
The HTML document opens. You see it as it might look when viewed by an HTML browser. If 
you want to use the optional Claris Works HTML stationery features, continue to the next step. 

5. Import the the HTML stylesheet into your document by following Steps 4-7 in the section 
"Creating HTML documents without using stationery." 

Note Imported text is styled as "Body+" in the stylesheet. However, the translator tags 

---·--·----··--------------·------------·------------------------------
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the text correctly when you export it, even when styled as "Body+," and you can use the 
stylesheet to style any new text that you type. 

6. Set up your document with the HTML shortcut buttons by following the steps in the Note in the 
section "Using stationery to create HTML documents." 

Formatting and editing HTML documents 
This section describes how to use Daris Works text and paragraph attributes to format or edit 
documents that can be translated to HTML format. 

Getting started · 
You start with a ClarisWorks word processing document. To create an HTML document, follow 
the directions in the section "Creating HTML documents." To open (import) an HTML file that you 
want to edit, follow the directions in the section "Opening HTML files". 

It's easier to apply the various text styles if you can see the carriage rerurns and spaces in your 
document. To show these characters-called invisibles or fonnatting characters--type 
Command-; (semicolon). To hide the formatting characters, type Command-; again. (The 
Command key is the cloverleaf key on the bottom row of the keyboard.) 

If you're using the Claris Works stationery, or if you've set up a word processing document so you 
can use the HTML stationery fearures, show the stylesheet (choose Show Styles from the View 
menu) and the shortcuts (choose Shortcuts and then Show Shortcuts from the File menu). 

Important Apply only those Claris Works styles that ~tart with "HTML" (for example, 
HTML Normal Text). With few exceptions, (noted in the applicable sections) the HTML 
translator and browsers don't recognize any other Claris Works styles. 

Paragraphs 
Type your text and end the line or paragraph by pressing Rerum (or place the insertion point in the 
text, choose Paragraph from the Format menu, and then type 1 in the space after box). The 
default paragraph style for the stationery is HTML Normal Text. The translator tags text styled as 
HTML Normal Text as a paragraph. Most browsers separate paragraphs by adding white space 
after the paragraph. 

Note The translator interprets soft rerums (Shift-Rerum) as spaces. 

If you don't want extra white space after a block of text, place the insertion point in the text, 
choose Paragraph from the Format menu, and then type O in the space after box. The translator 
will tag the carriage rerum as a break. Browsers don't usually add white space after a break. 

Tabs 
Tabs are usually translated into white space, except when the tabs appear in lists or preformatted 
text (see the sections "Lists" and "Preformatted text"). 

-------------------------------------------------~-----.--------------------------------------------------------~-
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Character formatting 
To make characters bold, italic, or underline, select the text and choose Bold, Italic, or Underline 
from the Style menu at the top of the screen. If you choose any other item from the Style menu 
(for example, Shadow or Inferior), the translator interprets it as plain text. 

Note The translator interprets most bold text as a header. Headers appear on a separate 
line when viewed from a browser. If you don't want the translator to interpret bold text as 
a header, make the font size of bold text 11, 12, or 13 points. 

Headers 
Use headers to structure and organize the HTML document, just as you·use headers to structure 
and organize any text document. To create a header, type the text, select it, and then choose a 
header style-such as HTML Header (9 pt.)-from the stylesheet (or choose Bold from the Style 
menu and any size except 11, 12, or 13 points from the Size menu). When the translator interprets 
text styled as a header, it adds white space above and below the text. 

Unsupported characters 
The translator ignores or interprets as spaces characters such as soft returns (Shift-Return), page 
numbers, page breaks, and date characters inserted by using the Insen Date command. 

Hypertext links 
A hypenext link is a string of clickable text (called an anchor). When you click on the link in a 
browser, you '1ump" to another document. 

To make a hypertext link: 
I . Select the text that you want to be seen as the link anchor. 
2. Click the Make Hypenext Link shoncut button (or style the text so it looks different from the 

surrounding text and then insert a footnote by choosing Insert Footnote from the Format menu). 

~ Make Hypenext Link shoncut button 

Clicking the button changes the selected text to blue underline and inserts a footnote mark. You 
see footnote text instructing you to fill in the Uniform Resource Locator (URL) of the document 
you are linking to. 

Note If you insert a footnote but don't change the anchor's appearance (for example, to 
blue underline), the translator uses the text preceding the footnote (up to 255 characters) as 
the link anchor. Note also that HTML doesn't support footnotes, so you can't use footnotes 
except to create hypertext links. 

3. Replace the footnote text "INSERT URL HERE" with the URL of the destination document. 
URLs represent file locations on the World Wide Web. A URL has the general form scheme: 
//host.domain [:pon] /path (filename. For more information on HTML and URLs, visit the 
WWW site at http://www.ncsa.uiuc.edu/demoweb/html-primer.html. 

---------------------------------------------------------------------------------------------------------------------
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Lists 
Use lists to group related items. List items always start with a tab (or a .5 inch indentation): You 
can show the relative importance of each item in a list by using multiple tabs (or muluple .5 mch 
indentations) to indent items-as you would in an outline. Items in ordered lists are numbered and 
items in unordered lists are set off with a bullet. You can include both ordered items and 
unordered items in the same list. 

To create a list: 
I. Press Tab to indent the line one or more times (or choose Paragraph and type a multiple of .5 

inches in the Left Indent box). 
Each tab character, regardless of tab size (or each .5 indentation, as cyped in the Left Indent 
box), adds an additional level of indention. 

2. Type the character that defines the type of list item (ordered or unordered). 

To create this tvoe of list ttem 
Ordered (numbered) 

Unordered (bulleted) 

Do this 
Type a number followed immediately by a period. right 
parenthesis, or a hyphen-for example, 1., !), or 1-. 
Browsers vary in how they format the numbers on ordered 
list items. 
Insert a bullet by clicking the Unordered List Item shortcut 
button (or type the bullet by pressing Option-8). Most 
browsers display a bullet at the beginning of each item in an 
unordered list. 

!·•'.( Unordered List Item shoncut button 

3. Type the text for the item. The text can extend to more than one line. 
4. Repeat Steps 1-3 for each item in the list. 
5. End the list by doing one of the following: 

• Start the next line of text at one less tab than the last item of the list. 

• Press Return to insert a blank line after the last list item, and begin the next text segment with 
a non-list character (that is, no bullets or numbers). 

Important Don't use styles from the stylesheet (such as Bullet or Diamond) to create lists in 
your HTML document-the HTML translator and browsers don't recognize Claris Works 
styles as list types. 

Example 1 Each additional list level is called an embedded list. 

!. The "l." is the beginning of the initial list. 
2. This is the second item of the initial list. 

l. Here we are at two list levels, thus we begin a new list. 
2. This is the second item of the embedded list. 

3. Here we end the embedded list, and continue the initial list. 

The embedded list could have been a bulleted list. The type of list (ordered or unordered) is 
determined by the first list item in that list level. 

------------------------------------------------------------------------------------------------------------------~-
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Example 2 This ordered (numbered) list contains an unordered (bulleted) list: 

1) The"!)" is the beginning of the initial ordered list. 
2) Second item of the initial list 

• First item of the unordered embedded list. 
• Second item of the unordered embedded list. 

3) Third item of the initial list. 

Example 3 This list shows that the first character of a new list determines if the list is ordered 
or unordered. When viewed by a browser, the list in this example is ordered exactly the same as 
the list in Example 2. 

1- The "1-" is the beginning of the initial ordered list.. 
• Second item of initial list (the bullet will appear as "2." in the HTML document) 

• First item of the unordered, embedded list. 
2- Second item of the embedded list. The number "2-" will be a bullet. 

3- Third item of the initial list. 

Pictures 
You can include pictures (images) in your HTML document. The translator supports anchored 
pictures, but not floating ones. To make sure your pictures are anchored, select the picture and 
choose Cut from the Edit menu. Then click in the text where you want the picture to go and choose 
Paste from the Edit menu. Correctly anchored pictures have one handle when you select them. 
(Floating pictures have four handles when selected.) · 

The translator automatically saves the pictures as individual files and creates tags in the HTML file 
that refer to the picture files. The references are to the same relative directory as the HTML file, so 
if you move the HTML document to another location, you must also move the picture files. 

The pictures are saved as PICTs, but to be able to view the pictures in the document on a WWW 
browser, you must convert them to Graphic Interchange Format (GIF). The translator adds the 
.gif extension to the picture filenames in the HTML source file, but you still must to convert the file 
from PICT to GIF format. When you've finished, check to be sure that the filename for each 
picture has the ".gif' extension in lower case. 

Note Shareware conversion applications such as GifConverter and GraphicsConverter 
are widely available from on-line services and popular Macintosh FTP archives on the 
Internet. 

Horizontal rules 
Horizontal rules are useful for separating sections of text. To insert a horizontal rule, click in the 
text and then click the Horizontal Rule shortcut button (or press Return, type a series of underscore 
characters, and then press Return again). 

~ Horizontal Rule shoncut button 

You see a series of underscores at the insertion point in the document. 

Preformatted text 
If you want a section of text to look exactly as you type it, select the text and then click 
HTML Preformatted Text in the stylesheet palette in the HTML stationery (or choose Monaco from 

---------------------------------------------------------------------------------------------------------------------
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the Font menu). Preformatted text appears in both your document and the browser in a 
monospaced font: 

This is an example of what 
preformatted text looks like. 
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Although tabs are supported in preforrnatted text, you should use spaces instead of tabs, because 
tab sizes can vary in different browsers. 

Literal text 
There are many features in HTML that the translator doesn't suppon. If you want to add advanced 
or unsupponed HTML commands to your document, select the text and·then click HTML Literal 
Text in the stylesheet palette in the HTML stationery (or choose Text Color from the Style menu 
and select a shade of red). 

Technical details 
This section describes some of the details of the HTML tags used by the translator. 

Character formatting HTML has two kinds of text styles, logical and physical. Logical styles 
are interpreted differently by different browsers. For example, the logical style <em> (that is, 
"emphasis") may be represented as red single underline by one browser and italics by another. 
Other examples of logical text styles are <strong> and <cite>. Physical styles, such as italic, 
underline:, and 11, 12, or 13 point bold, are represented as typed. When you format text as italic, 
underline, or 11, 12, or 13 point bold, the Claris Works HTML translator tags these physical 
character styles with logical character styles, like this: 

These tvoes of characters Are assianed thjs HTML tag 
Italics <cite> 
Underline <em> 
Bold (11, 12, or 13 point only) <strong> 

· NtJle If bold text is any size except 11, 12, or 13 points, the translator tags it as a header. 
See "Headers," below. 

Internatiional characters The translator suppons most of the ISO Latin 1 character set standard 
on both expon and impon. 

Special 1:haracters Some characters ( < > & ; and I) are used in HTML tags. If you type the 
charactef!, <. >, &, ; or/, the translator interprets them as typed. If you want the characters to be 
interpreted as pan of HTJ\1L tags, style the tags as literal text. See the section "Literal text." 

Paragraphs and carriage returns The translator tags as a paragraph ( <P>) any text followed 
by a hard return (created by pressing the Rerum key). The translator tags as a break (<BR>) any 
text block followed by a hard rerum that is formatted by placing the insertion point in the text, 
choosing Paragraph from the Format menu and then setting Space After to 0 (zero). 

Headers A header is a logical style. The size depends on the type of header. Browsers usually 
insen white space above and below the header and display headers as bold. 

If a text is bold, the translator checks the font size and then tags the bold text according to these 
rules: 

------------~-----------------------------------------------------------------~---------------------------~--~-
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If the bold text js this sjze 
Greater than or equal to 20 points 
Greater than or equal to 18 points and less than 20 points 
Greater than or equal to 14 points and less than 18 points 
Greater than 10 points and less than 14 points 
Greater than 9 points and less than or equal to 10 points 
Less than or equal to 9 points 

The translator taos the text as 
<Hl> 
<H2> 
<H3> 
<strong> 
<H5> 
<H6> 
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Lists For each list level, the translator inserts the tag <OL> for an ordered list and <UL> for an 
unordered list. For each list item, the translator inserts a list-item tag (<LI>). 

Horizontal rules If underscores begin and end with a hard Return, the translator insens the 
<HR> (horizontal rule) tag in the HTML document. 

About this HTML translator 
The HTML translator included with Claris Works 4.0 represents the joint efforts of Claris and a 
dedicated team at the Highly Interactive Computing Project (Department of Electrical Engineering 
and Computer Science) at the University of Michigan in Ann Arbor. 

Claris would like to express its thanks to the Highly Interactive Computing Project, including: · 

Brian Sullivan 
Ryan Day 
Sean DeMonner 
Jeff Spitulnik 
Amanda Pryor 
Edward Andrews 
Craig Braman 
Elliot Soloway 

Claris also extends its thanks Dr. Barbara Kurshan of Educorp Consultants. 

© 1995 Claris Corporation. All Rights Reserved. Claris and Claris Works arc registered trademarks of Claris 
Corporation. All other trademarks arc the property of their owners. 
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Mr. Oetzinger's 
fourth Grade Glass 

Click the Class to Go to our page! 

http://www.stanwood. wednet. edu/ues/ClassroomPages/Getzinger/Getzinger I .html 
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Mr. Oetzinger's 
I {ourth Orade Of ass 
"' "' . • 

Click on the pictures below to go to each page! 

Lunch 
Calendar 

Classroom 
Calendar 

Math! 
Event Of 

The 
Month 

Social 
Studies/Science 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger2.html 
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.. This week's Golden Tray winning class ,...., 

Monday 

5 
Chicken 
Burger 
Oven 
French 
Fries 
Applesauce 
Orange 
Shape up 
1% lowfat 
Milk 

*Com Dog* 
*Yogurt 
Combo* 

12 

Click For 
Our 

Mrs. Anderson's 2nd Graders! 

II Tuesday 

6 
Breakfast 
For Lunch 
Thick 
French 
Toast 
Ham Slice 
Hasbrown 
Pattie 
Orange 
Halves 
1% lowfat 
Milk 

*Yogurt 
Combo* 
*Burrito* 

13 
reakjast 

or Lunch 
Waffle/Maple 
Syrup 
Ham Slice 
Hashbrowns 
Fruit 
1% lowfat 

!!Wednesday 

7 
Turkey 
Fries 
Ketchup 
Tater Tots 
Celery 
Sticks 
Mini Rice 
Krispie. 
Treat 
1% lowfat 
Milk 

*Chicken 
Fried 
Steak* 
*Yogurt 
Combo* 

14 
Chicken 

uggets 
BBQ Sauce 
Oven Fries 
Com 
Fruit 
1% lowfat 

II Thursday 

1 

8 

• Click For 
Our 

PICK OF 
THE 

WEEKI 

15 Last 
Day! 

oFood 
Service 

II Friday 

2 

9 

1% lowfat 
Milk 

16 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger3.html 5/13/2001 
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PICK OF Milk Milk 

t THE 
WEEK! *Cook's *Cook's 

Choice* Choice* 

19 20 21 22 23 

26 27 28 29 30 

Click on Mr. G 

t 
To go back to Mr. Getzinger's 4th Graders main page! 

http://www.stanwood. wednetedu/ues/ClassroomPages/Getzinger/Getzinger3 .html 5/13/2001 



Ham and Cheese Deli Sandwich 

Lettuce, Pi.ckle Slices, Tomatoes 

Oven Potato Wedges 
Watermelon Wedges 

Oatmeal Cookie 
1 % Lowfat Milk 

*Chicken Burger* 
*Yogurt Combo* 

Click on Mr. G 

a 
To go back to the Lunch Calendar 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/LunchWkTwo.html 
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What's Happening in Mr. G's Room? 

Special Event - Outdoor Education Field Trip! 

I MondaI II TuesdaI llwednesdaI II ThursdaI II FridaI I 
2 
PTA 
CARNWAL!! 

1 Wild 
Waves 
Trip* 
*For safety 
patrol, 
kitchen & 
library 
helpers. 

(Last day of 
SFA) 
Ice 
Cream .50 

9 
5 6 7 

8 
FIELD 

5th Grade 5th Grade 5th Grade DAY! 
Outdoor Outdoor Outdoor 
Education Education Education coo/activities 

planned 
by Mr. 
Austin, 
PE teacher 

http://www.stanwood.wednetedu/ues/ClassroomPages/Getzinger/Getzinger7 .html 5/13/2001 
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12 
ROCKET 

13 14 15 16 
DAY 
All 4th Last Day 
graders 
have made Of School 
"pop bottle" 
rockets 

4WARDS for today's 
"blast off'! ASSEMBLY 

19 20 21 22 23 

26 27 28 29 30 

*What a great year we had ... * 

FIFTH GRADE - HERE WE COME! 

Click on Mr. G 

~ 
To go back to Mr. Getzinger's 4th Graders main page! 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger7.html 5/13/2001 



-... 
~ 

I . .· 

... -
In our classroom, we are learning how to do 
"Order of Operations". 
For example: 

27+3+4x2=} 
9+4x2= 17 

9+8= 

These are the directions to do this: 

1. Do mulitiplication or division first, 
going from the left to the right. 

2. As soon as you're done with 
multiplication or division, work from 
left to right to finish. 

Click on Mr. G 

~ 
To go back to Mr. Getzinger's 4th Graders main page! 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger4.html 
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Mr Getzinger's . 
fourth Grade Class 

At the Museum of Flight, we learned how airplanes work. 
We learned the four elements of flight: Lift, Drag, Gravity 
and Thrust. We also learned which controls do different 
things to the plane and how it effects the flight of the plane. 
We enjoyed learning these things about airplanes! 

This report was done by Andrew, Katie, Robert and Shannon 

Here we come, Museum of Flight! 
(Click on the "bus ride" to go with us!) 

Click on Mr. G 

a 
To go back to Mr. Getzinger's 4th Graders main page! 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger5 .html 5/13/2001 
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Museum Of Flight 

Cool! An old airplane! Come on! 

In this picture, we are learning how 
the plane steers. This one is yaw left 

and yaw right. Yaw means tum. 

Here are some of our students le 
about planes and how they are i 

We are imitating how an airpl 
turns. There are four elements: 

Drag, Thrust and Gravity. 

Click on the plane to see ,.. 
More Museum of Flight pictures! 

http ://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger9 .html 5/13/2001 
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Museum Of Flight 

Cool! Leaming the parts of the airplane 
as we make wooden ones. 

This flight 
simulator is 

a ride. 

,,,,,,,,\,.,"'-\\\.,, .. ,,,,,, . . .. 
'' '' Hun'""• 

Air Force One is a real pla 
you could take a tour on. Tl 
airplane that many past pre 

of the United States fle" 

Inside there is 
a screen and 
it feels like 

you are flying 
a fighter jet. 

Click on the bus to go 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger 1 0. html 5/13/2001 
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ROCKET DAY! 

Mr.G and Mrs. Chaplik 
~ready to "Fire Away" 

Mr. Olson, 
Mrs. Oldow 
and Mr. G. 

WOW!Watch that fly! 

Mr. Olson gives it a try! Oh YEAH ... we're having fun! 

Click on Mr. G 

~ 
To go back to Mr. Getzinger's 4th Graders main page! 

http://www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger 12.html 511312001 
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Washington State! 

Report by: Patrick, Kevin, KJ., Katy and Amanda 

Columbia Basin 

The Columbia Basin is in the Rainshadowofthe Cascade Range. 
The Columbia Basin also has Dry Falls which is an extinct water 

fall that was bigger than Niagara Falls! 

Cascade Range 

The Cascade Range is made up of th Cascade Mountain Range 
The Cascade Range has a variety of temperatures depending on 

the elevation. 

Puget Sound Lowlands 

http://www.stanwood. wednet. edu/ues/ClassroomPages/Getzinger/Getzinger I I .html 511312001 
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Stanwood is in the Puget Sound Lowlands. 
The Hood Canal Is in the Puget Sound Lowlands 

Okanogan Highlands 

The Pend Oreille is in the Okanogan Highlands 
The Colville Indian Reservation is in the Okanogan Highlands 

Coastal Region 

Olympia, the State Captial, is in the Coastal Region 
The Olympic Mountains are in the Coastal Region 

Click on Mr. G 

~ 
~ 

To go back to Mr. Getzinger's 4th Grade main page! 

http:/ /www.stanwood.wednet.edu/ues/ClassroomPages/Getzinger/Getzinger I I .html 5/13/2001 
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Example Classroom Web Sites 

Here is a list of Education Web Sites that are student appropriate for ideas. 

Cammack Elementary School: http://boe.cabe.k12.wv.us/cammack/ 

Creative Classroom Online: http://www.creativeclassroom.org/ 

Classroom Pages: http://www. k12hi.us/-maunawil/:classroom. html 

Mrs. Amelia P. Lee: http://www.k12.hi.us/-alee/c10/c10.html 

Mr. Campbell: http://www. k12. hi. us/-rcampbell/d13/index. html 

Mrs. Taylor: http://www.k12.hi.us/-mtaylor /d1 O/index.html 

North Canton Schools: http://viking.stark.k12.oh.us/-greentown/gyproject.htm 

Free Helpful Sites for Web Creation 

Webmonkey for kids: http://hotwired.lycos.com/webmonkey/kids/ 

LookSmart - Teacher Technology 

Computer Curriculum Corporation 

www.electronic-school.com 

Integrating Technology in the Classroom: 
http://www. siec. k 12. us/-wesUslides/integrate/index. him I 



Resources 

American Psychological Association. (1995). Publication Manual of the 

American Psychological Association (4th ed.). Washington, DC: Author. 

Center for Applied Special Technology, (1997}. The role of online 

communication in schools: A national study [On-Line], Available: 

http:/lwww.cast.org/publications/stsstudy/. 

Conyers, J.G., Kappel, T., & Rooney, J. (1999). How technology can 

transform a school. Educational Leadership, 56, (5), 82-85. 

P-46 

Day, W. (1996). Tech talk: The technology generation. American School & 

University, 23(12), 36. 

Doyle, A. (1999). A practioner's guide to snaring the net. Educational 

Leadership, 56 (5), 12-15. 

Eisenberg, M., & Johnson, D. (1996). Computer skills for information 

problem-solving: Learning and teaching technology in context. Syracuse, NY: 

Eric Clearinghouse on Information and Technology. (Eric Document 

Reproduction Service No. ED 392 463). 

Hancock, V., & Betts, F. (1994). From the lagging to the leading edge. 

Educational Leadership, 51(7), 24-29. 

Haughland, S.W., & Shade, D.D. (1997). NEA today learning: How young 

is too young? National Education Association Today, 15(9), 23. 

Holt, S. (1998, October 26). Wiring the classroom. Info World 93-99. 

Holzberg, C. (1995). What works: Technology in special education. 

Technology & Learning, 2, 18-23. 

Hruskocy, C., Ertmer, P.A., Johnson, T., & Cennamo, K.S. (1997). 

Students as technology experts: A "bottom-up" approach to teacher technology 



P-47 

development. (Report No. SP 037 528). East Lansing, Ml: National Center for 

Research on teacher Learning. 

(ERIC Document Reproduction Service No. ED 411 237). 

Li, P. (1998). Looking ahead technology. School Planning & Management, 

1, 7-11. 

Marsh, T. (May/June 1999). Ten stages of working the web for 

education. Multimedia Schools [On-line]. Available: http://proguest 

mi.com!pqweb?TS9936297 .. =1 &Ftm=4&Sid=7&Deli=1 &RQT=309&Dtp=1 /. 

Molnar, A. (1997). Computers in education: A brief history. Technological 

Horizons in Education Journal, 24(11), 47-58. 

O'Hara, S.P. (1998). A case study of attitudinal effects of internet use in 

a middle school integrated science curriculum. (ERIC Reproduction Service No. 

ED 417 978) 

Orwig, A. (1997). Integrating Technology: The Challenge and the Promise. 

Technology & Learning, 2, 38-43. 
Winans, D. (1996). Cover Story: Techno-hype or help? National 

Education Association Today, 15(4), 4-5. 

Withrow, F. (1997). Technology in education and the next twenty-five 

years. Technological Horizons in Education Journal, 24(11), 59-61. 



CHAPTER FIVE 

SUMMARY, CONCLUSIONS AND RECOMMENDATIONS 

Summary 

Stanwood, a commuter community north of Seattle, had beautiful 

and expensive computer laboratories that were being used primarily for word 

processing skill development. Many teachers felt overwhelmed and under 

educated on how to use this technology to give the students the maximum 

benefit from these beautiful labs. There was a need for a manual on how to use 

this technology to better their students' learning. 

As a result of a review of literature concerning the areas of technology 

available for use in education and the benefits of technology use in education, 

the author felt that a handbook on creating a classroom web page would greatly 

benefit teachers and students in the Stanwood School District. 

Conclusion 

In the opinion of the researcher, the handbook was very successful. 

Teachers who viewed the handbook were grateful to have a step by step guide 

on setting up a classroom web page. They were eager to get started on their 

own classroom web pages. 

I have learned a great deal from this project. I learned about the many 

different types of technology available for classroom use. I have learned the 

power that technology can have in motivating students and the possibilities it 

gives for deeper learning in students. I have also learned that patience in using 
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new technology is a must. Finally I learned that parents are very open to trying 

new approaches to teaching their children if it is in the best interests of their child. 

Recommendations 

This handbook has given teachers a starting point for using technology in 

a meaningful way in their classroom. There are still many ways in which this 

handbook could be improved. Some parents felt that many more components 

could be added to our web page. They felt strongly that access to an assignment 

sheet, detailing daily assignments would be beneficial. They also suggested the 

creation of a message board where teacher and parent could communicate on a 

regular basis. 

Teachers who have viewed this handbook had several suggestions as 

well. One suggestion was instruction on how to insert video and audio into their 

web site. Also the teachers would like to see all the classroom sites linked 

together into one community. 

It is the author's recommendation is that this project be modified as new 

technology becomes available and integrate that new technology into the 

classroom web page. Technology changes so fast that it would not be effective 

to simply use this model year in and year out without changing and adapting to 

new breakthroughs in technology. This project sets a basic starting point which 

can be used in many different ways to help students get the most out of their 

education. 
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